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Introduction

The aP23KWC24D USB Writer is designed to suppotu8@P89K series Voice chips. It is suitable for:

- aP89682K( 682 sec, 11 I/0O chip) — DIP24
- aP89341K( 341 sec, 11 I/O chip) — DIP24
- aP89170K (170 sec, 11 I/O chip) — DIP24
- aP89085K ( 085 sec, 11 1/O chip) — DIP24

This development system serves three main functions

Compiler —to create a dp2 file from user’s Voice files
Writer — to program the dp2 file into the aP23xx chip
Copier —connect DC 5V adaptor for 1 to 1 programming

The Compiler is used to combine the edited voice files intodhip to form the desired Voice Group and
to define the playback functions of each Voice Grby selecting different Options and Trigger Modes
of each individual Voice Group.

TheWriter is used to program the voice data into the aP28ex#ces that resulted from the Compiler
Function. A Writer Board connected to the PC viB port is required.

TheCopier is using the compiled *.dp2 which loads to writeen disconnect the USB and connect the
DC 5V for 1 pcs copying.
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Installation

Hardware Installation

aP23KWC24D is a USB based writer programmer. ilitsnded to be used in Windows XP,Win7,Win8
computer.

Writer Board Connection

1) Connect USB cable from the writer board to the cot@p The computer will display a new
hardware is found message. The installation veifjib automatically.

2) If there are too many USB devices are connectgouo computer at the same time, the current
supply from USB may not be sufficient to suppo# Writer board.

R IS R I I

'] Il‘r v

e~

Fig. 1 The aP23KWC24D USB Writer Programmr Board
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Running The Software

Double click the file23KWComplier.exeto launch the software.

COMPILER :

e 23KWCompiler-V2.4

Compiler | yuriter | About “
s Debounce
aP23682 - 8Pin ~ - [ BLLLE . Elpum e
[[Jpac @ 18ms () 65us
Wave File Output Option:
4
Grou edge
9
Type : Compression
®uawe 5 @ PCM16 Add-Wav
) PCMB () ADPCM4
File Name Size Rate Type Use %
8 VaiceFile
10
13
Usage : 528

(S|
Check Sum: 15
[F] PowerOnPlay [ ] Set Volume [ ] SBT Loop [¥] SBT Key3
Set Oscillator: [ |XT [ Ext [V]Int Set LVR: ] Off [C] On
Holdable Tri Sto Output
Prog - Bus Table Use Table Start T
14 12 11

< 2097152 (0 %) ’ LoadDp2 ] [ Compiler

COMPILER DESCRIPTION:

1. Select your required IC body.

--- aP23682-8pin , aP23341-8pin , aP23170-8pir23885-8pin.
--- aP23682-16pin , aP23341-16pin , aP23170-16ak23085-16pin.

--- aP89682K , aP89341K , aP89170K , aP89085K.

. Select your required trigger mode.

--- Key mode / CPU parallel mode / MP3 mode / SBten/ 12C mode / aP89 mode / SBT mode.

. Select voice output mode.
--- DAC or PWM.

--- The [xxx.wav]: 8 bits or 16 bits mono xxx.wav.
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5. Select the compression mode.
--- ADPCM4 / ULAWS8 / PCM8 / PCM16.

6. Select your required voice file [xxx.wav] folder

7. Select if adding the silence.
--- Ims ~ 10000ms.

8. Loading the required *.wav files.

9. Setting your required voice sections and fumctrade.

10. Show your final voice list.

11. Compiler: After setting the voices & functigrysh the button to create xxx.txt & xxx.dp2 files.
12. Re-download & Re-editing [xxx.dp2] to settimydafunction.

13. Show the memory of your usage.

14. Show the IC body memory size.

15. Show Check Sum.

P

e 23KWCompiler-v2 4

Compiler | writer | About Check Sum :
- Debounce ﬁ £ Ef%
aP23682 - 8Pin  ~ Key Mode .| Elpwm D 16 PowerOnPlay [ | Set VolumeT ] SBT Loop BT Key3
Cloac | @ 16ms O6%s | oo WRillator: [ ]xT []5xt [7] It 28 LVR: [7 Off [F]On
| Wave File | Output Option:
e ZBKWCDmpiler—M
Compiler | writer | About Check Sum :
aP23341 - 16PN ~ BoBiEn = Wrwm D_Ebf’“”CE ] PowerOnPlay [ Set Volume I‘ﬁCPU Serial Option
Cloac | ©16ms @65us oot gecillator: [F]XT [F]Ext [ Int Set LVR: [ OFf [F] On
Wave File Cutput Option:
Cutl :Busy-H Busy-H -

i 23KWCompiler-v2 4 .

' Compiler | writer I about Check Sum :
aP89170K +~ MP3 Mode L [pwm Debounce FowerOnFlay [] Set Volume 45—5 SET:P/P () SET:PfS
@ 5
[Cloac | @16ms 6555 oot oegillator: [T [T Ext [#]Int Set LVR: [¥] OFf []On
Wave File Output Option:
Outl :Busy-H 24  Busy-H + Qut3:Stop-H Stop-H -
Out2 ;LED- Flash LED- Flash -
I Group | edge | Holdable |Trig | Stop | Output

16. Select required debounce time.
--- 65us or 16ms.
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17. Select power on play.
--- Power on play [sw0] group once.

aP23KWC24D USB Writer User Guide

18. Select SBT pin swap. (for 8pin device only).
--- Select (SBT as OUT1) or (SBT as KEY3).

--- SBT as OUT1: Busy-H/L, Stop-H/L, LED Head_ED high active),
~LED Flash (LED low active), Prog-BusyH/L, LoadBit.

S3 (pin7) S2 (pin6) Group SBT = 0OUT1
0 1 SW1 Busy-H/L
1 0 SW2 Stop-H/L
1 1 SW3 LED ......

--- SBT as Keya3:

SBT ( pin5) S3 (pin7) S2 (pin6) Group
0 0 1 SW1
0 1 0 SW2
0 1 1 SW3
1 0 0 Sw4
1 0 1 SW5
1 1 0 SW6
1 1 1 SW7

19. Select if using the oscillator.
--- XT (X'tal=16MHz ) / Rosc ext ( 68K ohm/ Rosc Int.

20. Select if using low voltage reset.
--- Select ON if the IC voltage less than\@M be reset.

21. Select SBT loop. (At SBT mode).
--- Enable: The SBT pin sequential triggelo&p play.
--- Disable: The SBT pin sequential triggeplay once.
*Note: Voice function (Trig Level) must select Ledy

22. Select if using pin S4 as data output pin.
--- The SPI mode or 12C mode of data output fopR¥4IC body and 16 pin IC body.

23 SBT pin act play/pause or play/stop functionNtit3 mode.

24. Select the output function for outputl, outpaiZput3.
--- Busy-H, Busy-L.
--- LED Flash (LED high active ) , ~LED FladED low active ).
--- Stop-H, Stop-L.
--- Prog-BusyH, Prog-BusyL.
--- LoadBit: For the play command [094h+D94J09~D0] total 10 bits indicate the voice address
Same the aP89341 pref@itth [no gap loop play].
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= WRITER:
r —
i 23KWCompiler-v2.4 (P = S|
| Compiler | Writer |About| Check Sumn :
. Groui ’ edie ’ Holdahle ’ Trii ’ Stoi ’ Duﬁit 5 -
4
VoiceFile Prog - Bus Table Use Table Start o
5
6 7 8 ] % ] 10 3
Blank Check Program Verify Security aP23682 - 8Pn -
11 Run L 1
| | 0 % Load to Flash

WRITER DESCRIPTION:

1. Loading your programming file. (xxx.dp2)

2. Show setting and function after loading *.dg2.fi

3. Show your required IC body.

4. Show voice sections and function mode.

5. Show the content of your selected section afevtist.
6. Select to blank check IC is blank?

7. Select to execute programming.

8. Select to verify the data of your programming.

Page 7 of 21 2/1/2016



lf'LUE Integrated Circuits Inc. aP23KWC24D USB Writer User Guide

9. Select if you need security mechanism.
*** (If do this, it can’t be copied; it can’t be Mxer IC.)

10. Execute your selected (6.) (7.) (8.) (9.).
11. Show the progress of “blank check”, “prografwérify” and “load to flash”.

12. Load to Flash: download the program file (xp2pto [1 to 1 copier] writer.

= About:
, ..
e 23KWCompiler-V2.4 P Sy
Compiler | Viriter | About Check Sum :

'aP23xxx Series Voice OTP Development System

Version 2.4

Aplus Integrated Circuits Inc.

2 www.aplusinc.com.tw

sales@aplusinc.com.tw

SWriter Firmware Version Detect

2 Firmware Update

ABOUT DESCRIPTION:

1. Show software version.

2. Show website of Aplus Integrated Circuits Inc.
3. Detect writer firmware version.

4. Update writer firmware version.
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= Example for Compiler :

e 23KWCompiler-V2.4 =il s |

Compiler | writer | About " Check Sum :
aP23682 - 8Pin 2+ Key Mode b . | [#lPwm | Debounce [[] PowerOnPlay [ ] Set Volume [ ] SBT Loop [#] SBT Key3
[Cloac | @16ms L1855 | got oggillator: [ XT []Ext [7]Int Set LVR: [ Off [ On

Output Option:

Wawve File =
O.waw EI
lowav f

1testErr.wav

2. wav Holdable

3.wav
3200.wav

AA Mowav
L 1 2 Pleaze Select a Folder

Type : Compression
O uLaws @ PCM15 | Add-Wav |
b [ EEE

File Name Size Rate Type lUze %6 i @& RD
4N =g
|| b & FEHEEC) I
4, Data (D)

4 A

M| »

L wav|

L HEENE
i AIVR
i |, Builder_Project

Compiler

1. Select the IC body is [aP23682 - 8Pin].

2. Select [Key Mode] to be our trigger mode.
3. Select the voice output is [PWM].

4. Click Add-Wav to pick your required folder.
5. After confirming the folder, click the button.

6. All wav files in the folder will be listed here.
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|- [—
e 23KWCompiler-V2.4 S

Compiler | writer |About Check Sum :

aP23682 - 8Pn - Key Mode - Y D_Et’[’“"'CE_ [] PowerCnPlay [ ] Set Volume [ ] SBT Loop [#] SBT Key3
[Cloac | @ 16ms 6% | gor egillator: [ ]XT [1EBxt [7]Int Set LVR: [ OFf [F0n

Wave File » | Qutput Option:

boku.wav

CHILD. wav

Dog 01.way f
Dog-1@.wav

| Dog_ZZ.wawv

Jom |

Group edge Holdable Trig Sto Output

laugh 01.wav
MUSIC 02.wav

P R

Type : Compression
D ULAWS i) PCM16 Add-Wav

Fil I | Use 3
Silence Time (1 ~ 10000 mS -
g ( ) ok
1 0 VoiceFile | Prog - Bus | Table Use Table Start | T
20 mS Cancel | | LIt ] H ype
; G |
Jowav 7472 8000 PCM1& O
AA M.wav 20872 12000  PCME 1
boku.wav 35650 12000  PCMS 2
Silence : 20mS a 16000 Silence i}
9 I S N N
g-1
Usage:83578 < 2097152 (4%) | Loaddp2 | | compiler |

7. Show all your required *.wav files. Double clialav files you required in f, they will be showedg.
7a. If you once required multiple wav files to deowed in g. (Mouse left button as begin item after
mouse right button as end item and click Add-MWhav at the same time).
7b. 1t will show the memory size you has been used.
(Please note the data size you loaded can’t exbedoody’s memory).
*** Please note the data size you loaded can't eddbe body’'s memory. If so,
there are some ways to solve this problem:
1). Change it to a bigger memory size bodya®23085-8Pin to aP23341-8Pin.
2). Compressed the wav files to decreasenéraory size. ex: from PCM16 to PCM8.
3). Delete some required voice files.

8. If wav file is too big, we can choose compregdiles to decrease their sizes.
(UALW8 compress wav file to 8bits, PCM8 congmavav file to 8bits,
ADPCM compress wav file to 4bits).
*** Please note if your original voice is 16bits wéle which need to be compressed to 8 bits,
We suggest you choose ULAW would be better.
9. If you want to add mute voice, click Silencetbuatto set the silence time.

10. If need silence 20ms. Key in 20 (unit ms) thikck OK button.
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—

- | L

Compiler | writer | About Check Sum :
aP23682 - 8Pn  ~ Key Mode . ¥pwm E:bf;:cer':{ﬁm |:||F’D'~|'~rErUﬂF’lE'J.r Mt volume['] SBT Loop EET outl
Eloac | ® 1ms @655 | oy pcillator: []XT Exp[7/]Int Set LVR;[¥] Off [ On
Wave File + [~ Qutput Option:
boku. way Outl :Busy-H : Busy-H -
CHILD.waw S
Dog 01.wav =
Dog-1@.wav U Grou edge Holdable Tri Stoj Output
Dog_ZZ.wav
| laugh 01.wav |
MUSIC 02.wav )
'I_';]:lié_:. tompression
) ULAwS I PCM1B
i@ PCME (71 ADPCM4
File Name Size Rate  Type  Use % ||
0.wav 6732 8000 PCMI16E O :
Lwav 6412 a000 PCM16 O VoiceFile Prog - Bus Table Use Table Start T
2wav 5912 8000 PCM16 O
3way 7472 8000 PCM16 O
AA M.wav 20872 12000  PCM3 1
boku.wav 35850 12000 PCM3 2
CHILD.wav 91676 12000 PCM3 4
laugh 01.wav 22877 12000  PCM3 1
Silence ; 20mS 0 16000  Silence 0
Usage : 198131 < 2097152 (9%) LoadDp2 ] ’ Compiler
f"Lebounce PowerOnPlay [#] Set Volume . 4 '
i) 16ms @ 65us e
Set D’SC|”:'|||'Q|u|'|'|E Warp : DDISE']IE Enable Off D on
QOutput Option: n
Outl :Busy-H Busy-H VolLevel: 8 « VolDefault: 8 =
Set
E I ] ] ] ] _J
48] [ e [ O 7T = [T
11. Select the signal timing. (16ms or 65us).
12. Enable the power on play function, immediafgfy [SWO] once.
13. [Set volume] control function.
--Select the volume control Level x16 / x8 / x4.
--The volume control key by the [M1] and [MO] key.
Volume Warp: Volume level increase to the max thegin from the level 1.
Select disable:
Pin MO: volume Level [+ 1].
ex: Level x8, 2>32>4>52>6>7>8>8->8> ....
Pin M1: volume Level [- 1].
ex: Level x8, 72>6>524>3>22>12>12>1-> ...
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Select enable:
Pin MO: volume Level [+ 1].
ex: Level x8, 22>324>526>7>8>12>22>3> 4> ...

Pin M1: volume Level [- 1].
ex: Level x8, 7>6>52>4>3>2>1>8>7>6>5> ...

14. When trigger in “SBT mode”.
If enable the [SBT Loop]: It will one key sequehtidgger and keep loop play in every group.
If disable the [SBT Loop]: It will one key sequaltirigger and play one time in every group.
(*** Note: Trig Level must select Levl

y il 7 2
Debounce [[] PowerOnPlay [ | Set Volume [C] SBT Loop [¥] SB'E Outl
@ l6ms (U85S | get Oscillator 1 []xT Rosc BXt g SBTua;CILITl
Output Option: -

Out1 :Busy-H Busy-H x [C]SBT as KEY3
Set
\_ ; ; ; ; o

15. SBT pin swap other I/O pin function.
ex : SBT pin swap to OUT1 as output use.

16. Select set Oscillator from Crystal mode(X'téd#dHz), External Rosc mode(68K),
Internal Rosc mode. ( if selecting Crystal modenuist set at pin MO & pin M1).

17. Select set Low Voltage Reset when voltagettess 2V IC will be reset.
18. Output Option: Setup the outl, out2, out3.
Can select the Busy-H, Busy-L, Stop-H, Stop-L

LED Flash (LED high active), ~LED Flash(LED lowtee),
Prog- BusyH, Prog-BusyL, LoadBit.
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Compiler | yriter | About Check Sum :
aP23682 - 8Pin - Key Mode . | [@lpwm | Debounce [C] PowerOnPlay [ ] Set Volume [ ] SBT Loop [#] SBT Outl
@ 1ems () 65u 3 o .
[loac | @ 16ms 65 | o pegiliator: [1XT []Ext [71Int Set LVR: [F] Off [ On
Wave File = |~ Output Option: —
- = Busy-H

Dog DL.wav Out1l :Busy-H Y -

Dog-1@.wav

Dog_ZZ.wav

| laugh 01.wav H | Group | edge I Holdable I Trig I Stop I Output
MUSIC 02.way SWl Edge Unholdable Retrigger Enable

=3 wav Unholdable Retrigger Enable

5

Super 164 wav L SW3 Trig Level Hold Trigger Stop
ﬁ-;é-'*(;;rﬁ.;r;elssinn ) Level @ Unholdable ) Non-Retrigger ) Disable

) ULAWE I PCMIE Add-Wav @) Edge (7 Holdable @ Retrigger @ Enable

SW2 2 | ok || cancel |

File Name Size Rate Type Lse %6

O.waw 6732 3000 PCM 16 0

Lwav 6412 8000 PCM1e O VoiceFile | Frog - Busy | Table Use | Table Start | Type

2owav 5912 3000 PCM16 0 2. wav i 0 0 PCM 18
J.wav 7472 3000 PCM15 [i] soku.waw i 0 0 PCME
boku.wav 35650 12000 PCMS 2 CHILD, wav
| CHILD. wav 91676 12000  PCM3 4 | Up Panel - B
laugh 01.wav 22877 12000  PCMB 1

u Daown
Insert
Delete
Usage : 177355 < 2097152 (8% ) LoadDp2 ] l Compiler

19. Double click Panel-A for your setting the funatof each Group.

20. Key in group number.

21. SW means group. ex : Select the second gradid@uble click the wav files you required in (u¢th
Panel-B will show them.

The mouse moves to Panel-B then enter right keydar adjusting the order of the wav files or
insert or delete them.
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w 23KWCompiler-V

Compiler | writer I About * Check Sum : D47A
aP23682 - 8Pn  ~ Key Mode . @lpam Debounce [C] PowerOnPlay [ | Set Volume [ | SBT Loop @] SBT Outl
@ =
[Eloac | @ 16ms ©6%us | oy ecillator: []XT [JExt [@]Int Set LVR: [F] OFf [#] On
VWave File = | Output Option:
- - Busy-H -
Dog 0L.wav QOutl :Busy-H Y ‘
Dog-1@.wav
Dog_ZZ.wav i
.I.a'ugh 0L.wav |E Group | edae | Holdable | Trig | Stop | Cutput
MUSIC 02.wav SW1 Edge Unhaldable Retrigger Enable
=3.wav sw2 |Edge |Unholdable |FLE1:r1'gger |Enable |
Super 164, wav 5W3 Edge Unholdable Retrigger Enable
o e i V-l
Type : Compression SW-Begin: 2 Add v
©) ULAWE “) PCM16 Segiay Multi-Add
e o ulti-
@ PCM3 ) ADPCM4 Delete
Trig Level
) Level (@) Edge Play
File Mame Size Rate Type Use % = @ Edg
Hold Stop
Lo £7e2 fooe fRoms o6 @ Unholdable (7 Holdable
1Lwav 65412 3000 PCM15 0 VoiceFile le Start |Type
2.wav 5912 8000 PCM16 O 2.wav Trigger—— e PCM16
3.wav 7472 5000 PCM15 0 bokuway () Non-Retrigger (@ Retrigger PCME
bokuwav 30 12000 PCME 2 . e
CHILD. wav 91676 12000 PCM8 4 | © Disable @ Enable
laugh 01.wav 22877 12000  PCM3 1
Usage:177355 < 2097152 (8%) | LoadDp2 | [ Compiler ]

22. If the mouse move to Panel-A and enter riglyt kewill show there are additional function faidy

multi-add, delete, play and stop.
Add: add single group.
Multi-Add: add multi-groups at one time (v-1).
Delete: delete the group.
Play: play all voices of the group.
Stop: stop the voice playback.
23. Finish compiling, click compiler button.
24. Generate Check Sum number.

25. Loading finished compiled .dp2 file.
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o 23KWCompiler\

3 X | | x
Compiler | writer I about Check Sum : D474
aP23682 - 8Pin  ~ Key Mode . ] P D_Eh"“”CE ) [F] PowerOnPlay [ ] Set Volume [ ] SBT Loop [¥] SBT Qutl
[loac | @16ms ©85us | oot gegillator: [XT []Ext [7]Int Set LVR: [F]Off [# On
Wave File Cutput Option:
Outl :Busy-H Busy-H -
Group | edge | Haoldable | Trig | Stop | Qutput
I File is not exist _

Type : Compression
O uLAwS ) PCM15

X
g

1 H:\UsershuserDesktophDAwavh 2. wav

@ pPcMa () ADPCM4 nce . HAUsers\user\DesktophDAwavibokuway

i File Name Size Rate Type Use %
0.wav 6732 8000 PCM15 0
Lwav 6412 a000 PCM16 0
2.wav a i} PCM15 a
Jowav 472 8000 PCM16 0
pownay 00 povs o | | N N R R
[l CHILD.wav 91675 12000  PCM3 4
laugh 01.wav 22877 12000  PCMB 1
Play
Panel - C Stop
Remove
i Remove All
Modify Path z-1
_Jsage:135697 < 2007152 (6%) | Loadbp2 | | compiler

26.(z) Reloading .dp2 file if the voice file (*.wjis not exist.

27. (z-1) The mouse moves to Panel-C then entet kigy for your modifying the path of the wav files
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=  Write the program file [ xxx.dp2 Jto IC :

[ 23KWCompiler-V2.4 i

Check Surn : D474

| Compiler | Writer |About|

| Group | edge | Holdable | Trig | stop | output H:\Users\user\Desktop\TTT\demo.dp2 -
SW1 Edge Unholdable Retrigger Enable Key Mode
w2 |Edge |Unholdable  Retrigger  |Enable | [MEEEEEL
SW3 Edge Unholdable Retrigger Enable Power On Play: Disable
Use: Rosc Int
C LVR: On
SBT as Outl
QutPutl: Busy- H b

Execute Blank Check...
Blank Ckeck Success
Execute Program...

Program Finish
— Security Success

WoiceFile Prog - Bus Table Use Table Start Type Execute Verify
Verify Success

boku.wav 1 i 0 PCM3

CHILD. wa i 0 0 PCM3

d
| e f
Blank Check Program Verify Security aP23682 - 8Pn -

9

Run a
100! % Load to Flash

a. Click [Load] button to load the program file k&lp2] file.
After loading, it will show Check Sum b~ c~d message.

e. Select Blank Check to check if this IC is blank.
Select Program to execute programming.
Select Verify to execute verification.
Select Security to execute IC security mechanism.
***(To avoid the data to be copied and it can’tdoenaster IC).

f. Click Run button to execute all your selecteris in e column.
(Il show (e.) progress & (b) message).
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g. Click [Load to Flash] button to download .dp2 fio Writer.
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When writer is able to be a 1 to 1 copier. ***Y must do g. step at first)
1. Disconnect USB.

2. Connect 5V adapter.

3. Push program key to execute programming.

4. When programming, yellow LED flash.

When programming finished, green LED light.
When programming failed , no LED light.
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= Example for About :

e 23KWCompiler-V2. =

Cormpiler | Writer | About Check Sum : D474

aP23xxx Series Voice OTP Development System

Version 2.4

Aplus Integrated Circuits Inc.

a www.aplusinc.com.tw

sales@aplusinc.com.tw

b Writer Firmware Version Detect

C Firmware Update

a. Double click thevww.aplusinc.com.twwill connect website Aplus Integrate Circuits Inc.

b. Double click the Writer Firmware Version will®ah writer firmware version.

c. Double click the Firmware Update will load firrave file.
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Inserting Devices into the Programmer

-  DIP package devices
- Device should be inserted align to the bottom ef2#-pin textool socket.

For

aP&9085K-DIP24
aP89170K-DIP24
aP89341K-DIP24
JaP80682K-DIP24

LB _ B B B B B R B B B =
-h-—-l—E--

F|-H|='-1-rr|.-'-1. ~ 0
A it o

'l'l
L By

| APZBKWCZ4D % B

HISTORY
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2015/03/27
aP23KWC24D User Guide.

2015/05/20
Dat file become dp?2 file.

2015/07/17
Add>Device map & Check Sum

2015/09/18
Add->Low voltage reset & CPU serial option.
Modify> Trigger mode & Silence time & Usage memory size Xe&ute Run component control.

2016/02/01
Add—> Auto detect writer firmware version.
Add-> MP3 mode Play/Pause & Play/Stop option.
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